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BEFORE LOADING THE TEMPLATES PLEASE READ THESE NOTES CAREFULLY 
Introduction 

This utility consists of two templates, suitable for use with Word 97 to Word 2003. They also work 
with Word 2007 - please read the accompanying notes on using the templates with Word 2007. 
 
NB The templates aren't suitable for WORKS.  Please ask if you require templates for a MAC. 
 
NADFAS2Intro.dot is used for creating a new Introductory section for a NADFAS Church 
Record. NADFAS2Section.dot is used for creating each of the sections for the Record 
(e.g. Metalwork section, Woodwork section). 
 
These notes relate to Release 2 of the templates (those including a figure 2 in the filename). 

Purpose of the templates 
NADFAS2Section.dot is a template that has the following uses: 

o It determines the initial layout of each document, for instance the margins and paper size. 
o Some text is already typed in the new document. Any pre-typed text can be altered later as 

appropriate. 
o It defines a set of styles. Users apply styles to achieve standard formatting of certain special 

pieces of text. For instance, on the first line of the entry describing an object, the object number 
and the name of the object must be correctly indented. 

o It offers AutoText. Users insert AutoText to enter standard pieces of text automatically. For 
instance a difficult or often-repeated piece of text such as the “long s” ∫ in an inscription, or the list 
of format numbers 1-10 with their standard text. 

o Macros are stored in the template. These automate repetitive or difficult tasks such as creating a 
new section document or disabling Word’s inappropriate automatic features. 

o It displays a special toolbar from which the macros, AutoText and some other useful commands 
can easily be run. 

 
NADFAS2Intro.dot is a separate template: 

o It determines the initial layout of the Introduction document. 
o More standard text is pre-typed into this document, such as a typical list of Section Numbers and 

a sample table of Abbreviations and References Used. Any of this pre-typed text can be altered 
later as appropriate. 

Using the features of the templates 
It is recommended that new Church Record documents be created using these templates, to 
ensure that work produced by the many groups around the country will have a similar 
appearance. 
 
Styles ensure that the correct formatting is applied consistently, especially controlling the indents 
and tab stops for Object and Format number lines. 
 
AutoText, macros and the special toolbar are provided to make the task of creating and editing a 
NADFAS Church Record easier. However, users are of course free to use other methods 
according to individual taste and experience.  

Terms used in these notes 
A Section (eg. Stonework) consists of many Objects (eg. font), whose description is recorded 
under a series of Format numbers (1. – 10. eg. maker’s name). 
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Setting up – things you do just once 
Copying the templates onto your computer 

We will assume that you have a fairly ordinary, stand-alone installation of Windows 95, 98, XP, 
Windows 7. If you are working on a network, or if you are not sure, you should talk to the person 
who installed Windows and Word before copying files onto your computer. 
 

1. The two templates which are supplied on the CD are to be copied into the following folder: 
 C:\ NADFASStyleGuide 
 
This means a folder called NADFASStyleGuide in drive C: in the root or “top” level (ie. not within 
any other folder). It is important to use this folder and not any other location, as the macros will 
look in this location for the information they need. 
 

2. Once the pair of templates has been copied onto your computer’s hard disk, you do not need the 
CD any more. Put it away in a safe place or give it back to your group leader. 

Creating a dedicated custom dictionary for NADFAS work 
1. Start Word. 

2. Create a new dictionary, as follows: 

3. From the Tools menu, choose Options. 

4. In the Options dialog, display the Spelling & Grammar tab. 

5. Halfway down this dialog, notice a text box that specifies which custom dictionary is in use at 
present (probably CUSTOM.DIC). 

6. Click the Dictionaries button. 

7. In the Custom Dictionaries dialog, click the New button. 

8. In the Create New Dictionary dialog, find the File name box and type into it NADFAS.dic (not 
case-sensitive). 

9. Click the Save button. 

10. The new dictionary, NADFAS.dic, should now appear in the list of custom dictionaries, with a tick 
to show that this dictionary is now in use. 

11. Close any dialogs. 

Comment on viruses 
The NADFAS Section template contains macros, which automate some repetitive tasks in 
creating a NADFAS Church Record. When you use the template, Word may display a warning 
about viruses, because macros can be used to spread computer viruses (a virus is malicious 
code which may attack your computer’s functioning or the data stored on it).  
 
Both NADFAS templates have been virus tested when distributed; however you should always 
scan material before use, if it does not come from a trusted source. 

Edit the header – Group Leader only 
The name of the church being studied, with its town or village, is set in the header of each 
document. 
 
A header is a piece of text that is printed across the top of every page (usually) and it is not 
normally edited by group members. 
 
The Group Leader will probably edit the headers in both templates before issuing copies to the 
group members, inserting the correct name of the church, county etc. Refer to the Appendix 
(page 7) for instructions on how to edit the headers in the template. 
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If you are using these NADFAS templates for the first time, it is suggested that you leave the 
sample headers unchanged initially, while you examine other features. A sample church name 
and county have been inserted as an illustration. 

Starting a session – things to do each time you start NADFAS work 
Load Nadfas2section.dot as a global template 

This means you use the Templates dialog to specify that this template is a global template, so 
that many of its features, such as toolbars, macros and styles, will be available when working in 
any document. 

1. In the Tools menu, choose Templates and Add-Ins. 

2. In the Templates and Add-Ins dialog, look at the list of Global Templates and Add-Ins. If 
Nadfas2section.dot is already in the list, put a tick (a check) in the box beside it and click OK, 
then skip to no.8. 

3. If Nadfas2section.dot is not already in the list, this is how to get it: 

4. Click the Add button. 

5. The Add Template dialog shows a list of the templates available. If Nadfas2section.dot is 
shown, click it and click OK, then skip to no.7. 

6. If Nadfas2section.dot is not yet shown, navigate to the folder where it is to be found 
(ie. C:\NADFAS, where you copied the templates when setting up, see above). When found, click 
the filename and click OK. 

7. In the Templates and Add-Ins dialog, ensure that Nadfas2section.dot appears in the list of 
global templates with a tick. Click OK. 

8. Confirm by noticing that a new toolbar is displayed, with these buttons: Create New Section, 
Special, AutoText and Index Markings. 
 
The NADFAS2Section template is now a global template, so its macros, toolbars, etc. will be 
available when working in any document. When you close Word, it will cease to be a global 
template, so repeat this procedure next time you start Word to continue NADFAS work. 

Display the NADFAS toolbar 
This toolbar is displayed when the NADFAS2Section template is loaded as global. If at any time 
it disappears, this is how to display it again: 

1. Point the mouse to any toolbar. 

2. Right-click (i.e. click with the right-hand mouse button). 

3. A shortcut menu now appears, which lists all the toolbars that are available. Typically, Standard 
and Formatting will already be checked (a tick appears beside each). 

4. NADFAS Reports should appear on this list. If not, the NADFAS2Section.dot template is not yet 
global, so try the procedure again as described above for loading it as a global template. 

5. Click NADFAS Reports on the menu (use the left mouse button). A tick appears beside the 
toolbar name and the NADFAS toolbar is displayed. 

Disable/Re-Enable Word’s automatic features 
Some of Word’s automatic formatting and text entry features are inappropriate for this work. Use 
the special command provided on the NADFAS toolbar to turn them all off, as follows: 

1. Click Special on the NADFAS toolbar. A menu appears. 

2. Point to Word’s Automatic Features. A submenu appears. 

3. Click Disable on the submenu. 
The automatic formatting etc. will remain disabled until you re-enable them. 
 
At the end of this session, you may wish to turn on all the automatic formatting and text entry 
features again: use Re-Enable Auto Features from the Special menu. 
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Set/Unset the NADFAS custom dictionary 
1. Click Special on the NADFAS toolbar. A menu appears. 

2. Point to Dictionary on the menu. A submenu appears. 

3. Click Set NADFAS Dictionary on the submenu. 

4. The NADFAS custom dictionary is now active. Any words listed in this dictionary will be passed 
by the spell-checker as correct. If you click Add during a spell-check, the selected word is added 
to the NADFAS custom dictionary. Take care to Add only words that are spelt correctly. 

5. When NADFAS work is finished, you may wish to unset the NADFAS custom dictionary. A 
command is provided on the Dictionary sub-menu, found on the Special menu. Then Word’s 
default Custom.dic is set as the active dictionary. 

Creating a new Section document for a NADFAS Church Record 
 

1. You may wish to close any open documents. 

2. On the NADFAS toolbar, click Create New Section. A menu appears. 

3. Click the type of section required. 
A new document is now created. It is based on the template Nadfas2section.dot, and some text 
is already inserted. It is ready for you to type each of the Objects with their details. 

Entering the name of the first object 
1. The first Object number and/or name may already be typed. 

2. Type the first Object name as necessary, Tab (twice if appropriate) and type the location. 
(This paragraph is automatically formatted with the Object style.) 
The name of the Object should be made bold: use the  B  button on the Formatting toolbar or 
your preferred method. 

Entering the information about an object (numbers 1 – 10) 
1. Pressing Enter after the location creates a new paragraph, which has the FormatNumber style. 

2. From the AutoText menu on the NADFAS toolbar, click Formats 1-10. 

3. This inserts a set of format numbers, each with a message hinting at the expected text. 

4. Type the correct text for each format number, replacing the messages in square brackets. For 
instance, replace a phrase such as “[material]” with a proper statement of what the material is. 

5. If the text at one of the format numbers is long (such as the Description), and requires a further 
paragraph, press Enter to insert a new paragraph. The new paragraph will have FormatCont’d 
style. 

6. When ready, insert a blank line paragraph after number 10. 

Entering another object 
1. On a further new line, apply the Object style. Use the Style drop-down list box (usually at the left 

end of the Formatting toolbar); drop down the list of styles and click Object. Alternatively, use the 
keystroke  Alt + o . 

2. Type the number, then Tab once. 

3. Type the name of the next object, Tab (twice perhaps) and type the location. 

4. The Object name may be formatted in bold. 

5. Continue as above, inserting the AutoText for Formats1-10 and typing the text required. 

Note: some bulk items, eg. everyday Bibles, may be listed under one number using a. b. c. 
instead of the 1-10 format. In this case, set up the object line as usual, then on a new line do not 
insert the AutoText for the Format 1-10 but simply type the letters and text required. 
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Working on a record – using some of the dedicated commands 

Hide Spelling/Grammar Errors 
Spelling errors are displayed underlined in red, grammar errors in green. Suppress this if you 
prefer, as follows: 

1. On the NADFAS toolbar, choose Special; Hide Spelling/Grammar Errors. 

2. When errors are hidden, a check (tick) appears beside the command on the menu. These two 
commands are toggles: click each one again to uncheck it and display error underlining again. 
These settings are made for each document separately. 

Show table gridlines 
Lists of bells or hassocks and some of the standard lists in the Introductory pages are usually laid 
out in tables. While editing, you may find it useful to see the gridlines. 
 
On the Special menu, click Show Table Gridlines and ensure that the button beside this menu 
command is shown depressed. Now the grey table gridlines become visible on screen (they will 
not be printed out). If preferred, click the same menu command again to hide the gridlines. 

Change the Normal font 
The Normal style is the underlying style that controls the appearance of most text in the 
document. The default font (typeface) is Times New Roman. Use the Special menu on the 
NADFAS toolbar to change the underlying font of the current document quickly: 

1. On the NADFAS toolbar, choose Special; Change the Normal Font. 

2. A submenu appears. Click Arial. 

3. Change back to Times New Roman if preferred, using the same menu. 

Insert AutoText 
1. Move the insertion point (“typing cursor”) to a suitable point in the text. 

2. Click AutoText on the NADFAS toolbar. 

3. Read the menu of AutoText items available. Click one. 

4. The chosen piece of text/graphics will be inserted at the insertion point. 

List of Commands and Options provided on the NADFAS toolbar 

Create New Section 
Each option on this menu runs a separate macro. Each macro creates a new document, based 
on the NADFAS templates. 
 
Create Introductory Pages creates a new document based on NADFAS2Intro.dot. The 
remaining Create options each create a new document based on NADFAS2Section.dot, 
inserting a suitable section name in the header (eg. Woodwork), a comment on the condition of 
items and one or more Object numbers which are pre-assigned (eg. 700 East Window). 

Special menu 
Dictionary   set the NADFAS dictionary as a custom dictionary 
Word’s automatic features enable or disable them 
Hide Spelling Errors  hide or show the red underlining 
Hide Grammar Errors  hide or show the green underlining 
Change the Normal font the underlying font of the document may be Arial or Times New Roman 
Superscript a font format: any text selected is formatted to be superscript 

AutoText items 
These are all found on the AutoText menu. The AutoText button is on the NADFAS toolbar. 



Styleguide User notes MSword 2011 
6 

Format numbers 1-10: 
 1 [type the description here] 
 2 [type the material here] 
 3 [type the date here] 
 4 [type the measurements here. measure in cm or g. h x w x d in that order, or l x w for textiles 

and floor slabs] 
 5 [type the artist, designer, craftsman etc. here] 
 6 [type the manufacturer or retailer here] 
 7 [type a brief history of the item or donor or family] 
 8 [type the donor and date of presentation to the church] 
 9 [type the inscription here – only memorial inscription or dedication; other quotations and 

description of the type of lettering should go at 1] 
 10 [type references here. Should be entered as, for instance a) here, but (ref. a) in text above.] 

A table for bulk items such as hassocks 
Insert this piece of AutoText and type suitable text in the table: 

 
Design Worked by Donated by Dedicated to 
    

A table for items given in memory 
Insert this piece of AutoText and replace the sample text in the table: 
 

Items given ‘In Memory’ and recorded in other Sections 
 

BAKEWELL George Victor d 1945 see 323 

A table for bells 
Insert this piece of AutoText and replace the sample text in the table: 

 
Bell No. Diam. 

cm 
Inscription Weight 

cwt 
Note 

1 65 GLORY TO GOD IN MEMORY OF THE   
SIXTIETH YEAR OF THE HAPPY REIGN OF 
H.M. QUEEN VICTORIA - 1897 

4¼ F# 

“The following items” text 
The following items are in poor condition. 
The following items were present on the day of recording. 

The long s 
This may be used in inscriptions: ∫ 

Picture boxes 
The larger box is roughly postcard sized and leaves no room for text on either side. 
The smaller box is a 6cm square. It lies against the right margin, and text wraps on its left. 
 
Note that picture boxes are not displayed in Word’s Normal View. They are displayed in Page 
Layout View (Print Layout View in Word 97) and of course in Print Preview. 
 
When these picture boxes are inserted, they have pale grey borderlines so you can see where 
they are on the printed page. The borderlines can be re-formatted using Word’s usual commands 
(Border button or Borders and Shading on the Format menu). 

Notes on some Sections 
Memorials 

On the line where the object is named, type name(s) of the deceased, with date(s) of death, 
centred. A centring tab stop is provided. 
If there is another deceased’s name and date, or if the first deceased’s name and date are too 
long to fit on the Object line at the centre tab stop, they go on the next line. Use the centring tab 
stop and underline as desired. 
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At the end of the Memorials Section, usually include a list of items given in memory, in a table. 
Insert this standard table using AutoText. 

Textiles 
Hassocks – if there are a great number, all of similar size and all canvas work, give a general 
description then insert the standard table using AutoText. 

Bells 
Insert a standard table for the bells, using AutoText. 

Appendix Editing the Church Name etc. in the Header 

a Opening the Section template for editing 
First you must open the template itself, as follows: 

1. You may wish to close any open documents. 

2. Display the Open dialog (by clicking the Open button or otherwise). 

3. Find the Files of Type box. Click the grey arrow to display a list of options. 

4. Choose Word Templates .dot 

5. Find the Look In box. Click its grey arrow to display a diagram of some of the computer’s folders. Navigate 
to C:\NADFASStyleGuide. 

6. The templates NADFAS2Section.dot and NADFAS2Intro.dot should now appear in the list of documents. 
Click NADFAS2Section.dot and open it. 

7. Confirm by looking at the title bar that the template itself is open, and this is not just a Document based on 
the template. 

b Opening the Header/Footer 

1. Look in the View menu and click Header and Footer. It doesn’t matter where you are in the document when 
you click the View; Header menu command. 

2. The Header text now becomes black (was grey) and the main document text now becomes grey (was 
black). 

3. A special Header and Footer toolbar appears. 

4. You can now edit the header text as appropriate, replacing the sample text in the centre cell of the table. 

c After editing 

1. When finished editing the header, click the Close button on the special Header and Footer toolbar to return 
to the main part of the template. 

2. Close the template, saving changes when prompted. 

d Editing two headers in the Intro template 
In NADFAS2Intro.dot, there are two headers! There is a longer one for the first page only, and a shorter 
one for the rest of the document (in principle, a document could have many headers). 
You must edit them both independently, as follows: 

1. Open NADFAS2Intro.dot as described above. 

2. Open the header for editing. 

3. Use the Show Next/Show Previous buttons on the special toolbar, to switch between the headers. 

4. Header text is set up in a table of 3 cells (Table; View Gridlines if you want to see grey lines on screen). 

5. Now alter the text in each header as appropriate, replacing the sample text provided. 

6. When done, click the Close button on the Header and Footer toolbar and return to the main part of the 
template. 

7. Close the template document, saving changes when prompted. 
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